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Total War Main Program 

Introduction 
 
This help file covers the features and functionality of the Main Program of the 
Strategic War series of games. All menus and dialogs associated with the 
Main Program are covered in this help file. For further information on the game 
system and editors, you should review the following help files: 

• Strategic War Users Manual 
• Scenario Editor Help File 
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The Menus 

File Menu 
 
The File Menu is used to start new battles, save battles, and open existing 
battle files. 
 

Selecting New will display a File Open dialog so that a new 
battle can be started from a Scenario file. Note that Scenario 
files have the extension scn by default. 
Selecting Open will display a File Open dialog so that an 
existing battle can be opened. Note that Battle files have the 
extension btl b
Selecting Save will cause the current battle to be saved to a 
Battle file. If the current battle does not already have a filename, 
you will be prompted with the File Save dialog to specify one. 
Note that the use of the Auto Save option from the 

y default. 

Settings 
Menu greatly reduces the need to use this function. 
Selecting Save As will display a File Save dialog so that a new filename can 
be specified for the current battle. Use this function if you want to avoid 
overwriting an existing Battle file. 
Selecting File Selection will display the File Selection Dialog. 
 
Selecting Shapshot allows you to save a copy of the current battle screen to a 
Windows™ BMP graphics file. You will be prompted for the name of the file. 
Selecting Replay will display a File Open dialog so that a Replay file can be 
read and replayed. Replay files are created using the Record Battle option of 
the Mode Menu. By default Replay files have the extension btr. 
 
Selecting Exit will close the main program. If the current battle is unsaved, you 
will be prompted to save it. 

Turn Menu 
 
The Turn Menu is used to advance the current battle to the next turn. 
 

Selecting Next will advance the current battle to the next Turn. If the 
Auto Save option of the Settings Menu is set, then the battle will be 
saved before advancing the turn. If no filename has been specified 

for the current battle, this will also cause a File Save dialog to be displayed so 
that this filename can be entered. Note that since the Auto Save option saves 
the battle before advancing the turn, it is possible to back-up to the previous 
turn by using Open from the File Menu and opening the Battle file after 
declining to save the current battle. 
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When the Turn is advanced, the Command Dialog is displayed indicating 
information about the battle to the current player. 
 
If you have any reinforcements that have arrived, but have not been placed, 
then advancing the turn will cause you to be prompted to place these 
reinforcements. 
 
When playing Multi-Player Network play, only the Commander of each side 
can advance the turn. When any other player of that side selects Next, it will 
indicate that the player is ready to finish the turn by displaying the player name 
in red in the Multi-Player Dialog. 

Command Menu 
 
The Command Menu is used to perform certain functions on units such as 
changing entrain and embark status. 
 

Selecting To Top of Stack will move the currently 
selected units in the current Hot Spot to the top of the 
stack. 
Selecting To Bottom of Stack will move the currently 
selected units in the current Hot Spot to the bottom of the 
stack. 
Selecting Entrain/Detrain will toggle the entrain status of 
the selected units.. 
Selecting Embark/Disembark will toggle the embark 
status of the selected units. 
Select Combine/Breakdown to combine the selected 

components into a single unit or to split a unit with multiple components into 
those components. 
 
Selecting Remove From Map will remove the selected units from the map. 
This can only be done from a boundary hex on the map. This function is most 
often used in conjunction with Exit Objectives. 
 
Selecting Air Support will display the Air Support dialog so that air missions 
can be invoked. 
 
Selecting Undo Last Movement will undo the last move made and return the 
units that were moved to their starting location. Note to avoid information leaks, 
this function is not available when Fog of War is in effect. 

Combat Menu 
 
The Combat Menu is used to perform functions relative to combat attacks 
against enemy hexes. 
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Selecting Clear Combat will reset any attack which has 
been initiated but not yet resolved. Use this function when
you change your mind about an attack and want to try 
some
Selecting Add to Combat will add the currently selected 
units to the current attack. Alternatively, you can add units to

an attack using drag-and-drop by dragging the mouse from the hex containin
the selected units to the target hex and 
Selecting Combat Details will display the internal values used in the current 
combat calculation so that you can better understand how the final combat 
odds are determined. 
Selecting Resolve Combat will resolve the current attack and display the 
results. 

 

thing else. 

 
g 

releasing it. 

Units Menu 
 
The Units Menu is used to view and place reinforcements and to view other 
data associated with the current scenario. 
 

Selecting Scheduled displays the Scheduled Dialog 
which shows the reinforcements scheduled for the 
current battle. 
Selecting Arrived displays the Arrived Dialog so that 
units that have arrived as reinforcements can be placed 
on the map. 
Selecting Releases displays the Release Dialog so that 
Releases of Fixed units can be viewed. 
Selecting Scheduled Replacements displays the View 
Replacements Dialog so that future replacements can 

be viewed. 
Selecting Available Replacements displays the Available Replacements 
Dialog so that replacements can be assigned to units. 
Selecting Air Availability displays the Air Availability Dialog which shows 
changes in air availability associated with the current scenario. 
Selecting Withdrawals displays the Withdrawal Dialog so that the Withdrawals 
for the current scenario can be viewed. 
Selected Destroyed displays a list of all of the units destroyed (reduced to 
strength 0) in the current scenario. 
Selecting Strategies displays the Strategy Dialog so that any Reinforcement 
Strategies defined for the current scenario can be viewed. 

Info Menu 
 
The Info Menu is used to display summary information about the current 
scenario such as the strength of on-map units and the ownership of map 
objectives. 
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Select Strength to display the Strength Dialog. This will 
show the total strength of all on-map units in the current 
scenario. 
Select Cities to display the City Dialog so that a list of cities 
on the map can be displayed. 
Select Locations to display the Location Dialog showing a 
list of all on-map locations. 
Select Objectives to display the Objectives Dialog to see a 
complete list of all of the Objectives associated with the 

current scenario. 
Select Supply Sources to display the Supply Sources Dialog to see a 
complete list of all of the Supply Sources associated with the current scenario. 
Selecting Victory displays the Victory Dialog showing the current Victory 
conditions. 
Selecting Weather will display a report showing the 
current weather conditions and forecast. 
 
Selecting Transportation will display the 
Transportation Dialog showing the current 
transportation usage. 

View Menu 
 
The View Menu is used to establish display settings such as the map display 
resolution and the display of various scenario on-map data such as objectives. 

 
Select Units Off to hide the units that are currently on the 
map. This is used when you need to see map details that 
are hidden by the units. 
Select Objectives to toggle the display of Objectives on 
the main map and the Jump Dialog. 
Select Strategic Targets to toggle the display of Strategic 
Targets on the main map and the Jump Dialog. 
Select Partisans (or Insurgents) to toggle the display of 
Partisans and Insurgents on the map. 
Select Ownership to toggle the display of City Ownership 
on the map. 
Select Supply Sources to toggle the display of Supply 
Sources on the map. 
Select Search for Unit to display the Find Unit Dialog. 
Using this dialog, you can find any unit by name that is 
currently on the map. 
Select Jump Map to display the Jump Dialog which 
enables you to quickly go to any location on the map. 
Select Specials on Top to toggle the display of special 

markers such as fortifications on top of the unit stack instead of underneath. 
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Select Organizational Colors to toggle the display of colors on the units that 
have broken down to indicate which division they belong to. 
Select Hex By Coordinate to enter the hex coordinates of a location which the 
program will then scroll to. 
Select Counter Value to display the Counter Value Submenu described 
below. 
Select Highlight to display the Highlight Submenu described below. 
Select Shade to display the Shade Submenu described below. 
Select Clear Highlight/Shade to clear all highlighting and shading in effect. 
 
Select Zoom-Out View (Hot Key 1) to display the map in reduced size 
graphics mode. 
Select Normal View (Hot Key 2) to display the map in normal size graphics 
mode. 
 
The Counter Value Submenu is used to display various values on top of the 
counters on the map. 

Select Number of Units to toggle the display of the 
number of units in each hex. 
Select Stack Points to toggle the display of the total 
number of strength points in each hex. 
Select Attack Points to toggle the display of the total 
attack points in each hex. 

Select Defend Points to toggle the display of the total defend points in each 
hex. 
Select Movement Points to toggle the display of the minimum movement 
points for the units in each hex. 
Select Number of Components to toggle the display of the total number of 
components of the units in each hex. 
 
The Highlight Submenu displays a list of unit types and status values that 
may be selected to Highlight certain units on the map. Selecting any of these 
modes turns off any other highlighting mode that has been set. Selecting a 

mode that has already been set turns that mode off. 
Select Fixed Units to highlight units on the map which are 
currently Fixed. 
Select Fought Units to highlight units on the map that 
have participated in combat in the current turn. 
Select Moved Units to highlight units on the map that have 
moved in the current turn. 
Select Reduced Units to highlight units on the map which 
are reduced to 50% strength or less. 
Select Supply Units to highlight units on the map which 
are mobile supply units. 
Select Repair Units to highlight units on the map which are 

rail repair units. 
Select Entrained Units to highlight units on the map which are currently 
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entrained. 
Select Out-of-Supply Units to highlight units on the map that are currently 
out-of-supply. 
Select Engineer Units to highlight all engineer units on the map. 
 
The Shade Submenu is used to shade certain hexes on the map and thus 
display a certain range or capability. 

Select Major Supply Distance to display the range of 
Major Supply currently available. 
Select Minor Supply Distance to display the range of 
Minor Supply currently available. 
Select Amphib Supply Distance to display the range of 

Amphibious Supply. 
Select Reachable Hexes to display the hexes the currently selected units can 
move to. 
Select Command Range to display the hexes that are command range of the 
currently selected headquarters unit. 

A/I Menu 
 
The A/I Menu is used to control the Artificial Intelligence settings of the current 
battle. 

 
Each side can be set to one of four possible A/I 
settings. Select Manual to turn off all A/I for a 
side. This mode is used if you want to perform all 
of the movement and combat for the side. Select 
Automatic to turn on the A/I for a side. In this 
mode, the computer will perform all movement 
and combat for that side. Select Automatic with 
Fog-Of-War to establish Automatic A/I with Fog-
Of-War for a side. Under this selection, certain 

information about the enemy will not be displayed. 
Select Activate A/I to resume the A/I after it has been stopped. This is also 
used to resume A/I processing after a battle that was in the middle of an A/I 
controlled turn has been reopened. Note that attempting to advance the turning 
an A/I controlled turn will also cause the A/I to resume. 

Mode Menu 
 
The Mode Menu is used to select special modes such 
as Network Play and Play-By-E-Mail (PBEM). 
 
Select Direct-Play Host to initiate Network Play as 
the Host player. Select Direct-Play Caller to initiate 
Network Play as the Client player. See the section on 
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Network Play in the User Manual for more information on this feature. 
Select Play by E-Mail to place the main program in a mode for Play-By-E-Mail 
(PBEM). See the section on Play-By-E-Mail in the User Manual for more 
information on this feature. 
Select Two-Player Hot Seat to place the main program in a mode where two 
people can play a game on the same computer with each playing under Fog of 
War. In this mode, the main program will prompt before changing sides so that 
the appropriate person can take their place at the computer while the other 
looks away. 
Select Record Battle to begin recording the turns of the current battle. You will 
be prompted with a File Save dialog to specify the filename of the recording. 
By default recorded battles are stored in files with the extension btr. After you 
are through recording a battle or portion of a battle, you can terminate the 
recording by reselecting the Record Battle option. Once you have recorded a 
battle, you can replay it by using the Replay feature of the File Menu. Note that 
when you replay a battle, the perspective of the replay is that of the opposing 
side. That is, if you replay a battle that has been played using Automatic A/I 
with Fog-Of-War, you will see the battle from the perspective of the computer 
player. A battle replay can be paused by pressing the Escape key and can be 
resumed by using the Restart Replay feature described below. 
 
Select New Encryption Key if you are the Caller in Network Play and you 
want to specify a new encryption key to be used for the current battle. 
Select Resync if you are using Network Play and you suspect that the two 
computers have become out of sync with respect to the current battle. The 
player that chooses this option will cause their copy of the battle to be copied 
to the other computer. Note: since the current implementation of Network Play 
uses Microsoft’s Direct Play technology, this feature should rarely be 
necessary. 
Select Restart Replay to restart a battle replay that has been paused through 
the use of the Escape key. 
 
Select Communication Dialog to redisplay the Comm Dialog if it has been 
closed. 
If you are the Modem Host, then 
select Set Multi-Player Timer to 
display the Timer Dialog. This allo
you to establish a timeout value d
Network Play to ensure that everyone 
completes the phase in the specified 
number of minutes. After the specified 
number of minutes, the phase will automatically be advanced. To disable this 
feature, set the timeout value to 0. While the timer is running, the timeout 
status will be displayed in the 

ws 
uring 

Status Bar. When the indicator is green there 
is still at least a minute left in the current phase. When the indicator turns 
yellow there is less than 1 minute left. The indicator will turn red when 
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control passes to the other side. When the indicator turns orange there is 
less than 1 minute left in the opposing side’s phase. 
Select Multi-Player Dialog… to display the Multi-Player Dialog. This is used to 
see who is participating in the current Network Play game and to see and 
change their current assignments. 
Select Scroll to View Enemy Action to toggle the setting that causes the 
window to scroll whenever an enemy unit moves, fires, or melees. This feature 
is on by default, but automatically turned off whenever there is more than one 
enemy player in Network Play. 

Settings Menu 
 
The Settings Menu is used to select certain settings that are saved when the 
main program is exited and restored the next time the main program is run. 
These options are stored in the Windows Registry. 

 
Selecting the Introduction causes the main program to 
play the introduction including introduction video, and 
game cover art. 
Selecting the Prompt for Scenario option causes the 
main program to prompt you for a new scenario using the 
File Selection Dialog when the main program is run. 
Selecting the Beep on Error option causes the main 
program to generate a beeping sound whenever you 
perform an invalid operation. 
Selecting the Blink Hot Spot option causes the red 
outline in the Hot Spot hex to blink whenever the map is 
in a 2D graphics. 
Selecting the Auto Scroll option puts the map in a mode 
where moving the mouse cursor to any edge of the 
screen will automatically scroll the map in that direction. 
When this option is turned off, normal Windows scroll 

bars are displayed when the map is larger than the screen a
Selecting the Smooth Scroll option causes the map to scroll smoothly from 
one part of the map to another whenever the Hot Spot is relocated. With this 
option turned off, the map display will immediately relocate resulting in faster 
operation. 
Selecting the Sound Effects option causes the main program to play sound 
effects during combat. 
Selecting the Background Sound option causes the main program to play 
background sounds during each player’s turn. 
Selecting the Ask Before Advancing option causes the main program to 
prompt you before advancing the current turn or phase. Use this option if you 
find yourself inadvertently advancing the turn or phase by accident. 
Selecting the Auto Save option causes the main program to automatically 
save the current battle when the phase is advanced, except when the phase is 

rea. 
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under the control of Automatic A/I. Note that the battle is saved just prior to 
advancing the phase, so it is possible to reopen the battle file and restore the 
battle to the previous phase when the phase is inadvertently advanced. 
Selecting PBEM Encryption will cause PBEM battle files to be saved in an 
encrypted state using user-supplied passwords. 
Selecting the Hex Outlines option causes outlines to be drawn around the 
hexes in both 2D and 3D graphics mode. 
Select Boundaries to display the Boundaries Submenu described below. 
Selecting Hex Info Area displays the Hex Info Area Submenu described 
below. 
 
Selecting Optional Rules causes the Optional Rules Dialog to be displayed so 
that Optional Rules for the current battle can be reviewed. 
 
The Boundaries Submenu is used to determine which boundaries are 
displayed on the map. 

Select Country to toggle the display of country boundaries on the 
map. 
Select Front to toggle the display of air front boundaries on the 
map. 
Select Area to toggle the display of area boundaries o

Select Sea to toggle the display of sea boundaries on the map. 
n the map. 

 
The Hex Info Area Submenu is used to determine the location of the Hex Info 

Area on the screen. 

 

Selecting Left, Right, Top, or Bottom causes the Hex Info Area to 
be displayed in the corresponding location on the screen. 

Help Menu 
 
The Help Menu is used to display various help and other information about the 
main program including this help file and copyright information. 

Select General Help to display the Table of Contents of 
this help file. 
Select Users Manual to display the Users Manual help 
file. 
Select Campaign Notes to display the notes on the 
campaign. 
Select Parameter Data to display the Parameter Data 
Dialog which shows game values specific to the current 

scenario. 
Select Nation Data to display the Nation Data Dialog which lists information 
about the nations. 
Select Front Data to display the Front Data Dialog that shows air availability 
based on air front and the weather. 
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Select About to display various information about 
the Main Program such as version and copyright. 
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The Dialogs 

Command Dialog 
 
The Command Dialog appears at the beginning of a player turn and reports 
information about the battle. 
 

 

The Command Dialog will display a report for the current side indicating 
changes that have occurred at the beginning of the turn. 

A/I Selection Dialog 
 
The A/I Selection Dialog is used to select the A/I settings for each side in a 
new battle and other values. 

 
The A/I settings for the two sides 
correspond to the A/I settings 
described in the A/I Menu. Select 
Rules to display the Optional Rules 
Dialog so that the Optional Rules for 
the new battle can be established. 
Click on OK to begin the battle. 

New Scenario 
Dialog 

 
The New Scenario Dialog is used to establish starting conditions for two-
player games such as Network Play and PBEM. 
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Select either side for the Local Side. The other player will be the other side in 
the battle. If desired, select the Fog of War option. The Rules button will 
display the Optional Rules Dialog. Click on OK to begin the battle. 

Scheduled Dialog 
 
The Scheduled Dialog can be used to view the reinforcements defined for the 
current scenario. 
 

 

The Scheduled Dialog displays a list of reinforcements scheduled to arrive in 
the current scenario. Each reinforcement entry has an arrival date, an arrival 
probability, and an arrival hex. Note if Fog of War is in effect, then the 
reinforcements of the opposing side are not shown. Further, the arrival 
probabilities of friendly reinforcements are not revealed. If the arrival probability 
is not 100%, then there is a chance the reinforcement will not arrive at the 
exact arrival time. At the arrival time, and on each subsequent turn if 
necessary, the arrival probability will be applied to the reinforcement until it is 
determined that the reinforcement has arrived. Clicking on a reinforcement 
scrolls the map to the arrival hex. 
 
When the arrival probability is followed by a second number as in (prob%/-
attrit%), then that second number is the maximum attrition applied to the 
reinforcement when it arrives. 
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Each reinforcement in general consists of several units. Double clicking on a 
reinforcement entry displays a list of the individual units in that reinforcement. 

 

Arrived Dialog 
 
The Arrived Dialog is used to display units that have arrived as 
reinforcements and to place these units on the map. 
 

 

Selecting an entry in the list of arrived units and clicking OK will place the units 
on the map and close the dialog. Alternatively, double clicking on an entry will 
place the units on the map and keep the dialog open if there are more units to 
place. 
The Arrived Dialog is automatically displayed whenever there are units that 
have arrived that have not been placed and the phase has been advanced. 
Clicking Cancel will close the dialog and advance the phase. 

Release Dialog 
 
The Release Dialog is used to view Releases defined for Fixed units. 
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The Release Dialog displays a list of the Fixed unit releases in the current 
scenario. Each release shows a date, probability that the release will occur on 
that date, a distance, and a nation that the release applies to. When the 
probability is followed by the letter T, it indicates that the release can also be 
triggered whenever an enemy unit moves within the distance of the location. 
When an asterisk (*) precedes the release, it indicates that the release did not 
occur on the date specified. 

Strength Dialog 
 
The Strength Dialog is used to display the total strength of all units. 
 

 

The strengths of all units of each side are displayed by unit types. In addition, 
the total number of units of each type is shown. 
 
When a particular side has Fog-of-War set, then no values associated with that 
side are displayed. 

Objectives Dialog 
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The Objectives Dialog is used to display the current ownership and value of 
Objective Hexes. 
 

 

Each Objective is listed together with its current owner, location, and value. 
Selecting an Objective will scroll the map to the Objective location. Double-
clicking on a selection will also close the dialog. Following an objective may be 
a coded indicator as follows. 

• Exit Objectives are shown with an X following their value. When Fog of 
War is in effect, the value of enemy Exit Objectives is displayed as ??. 

• Surrender Objectives are shown with an S following their value. These 
are used to determine when a country will surrender. 

Supply Sources Dialog 
 
The Supply Sources Dialog is used to display a complete list of all of the 
Supply Sources associated with the current scenario and their owner. 
 

 

Each Supply Source on the map is listed with the owner, location, and value. 
Selecting a Supply Source will scroll the map to the Supply Source location. 
Double-clicking on a selection will also close the dialog. 

Victory Dialog 
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The Victory Dialog is used to view the current victory conditions. 
 

 

Victory conditions are always calculated relative to the first side. The victory 
level for the other side is the opposite result. For example, if the first side gets 
a Major Victory, then the other side suffers a Major Defeat, and so forth. 
 
The total number of Objective Points and Strategic Points are displayed. For 
each side, the Losses of each side are listed together with the Point Loss 
corresponding that. The point range associated with each victory level is 
displayed in the Victory Values field. The total points awarded to the first side 
are based on the Objective Points plus the Strategic Points, minus the Point 
Losses for the first side, plus the Point Losses for the other side. This 
calculation results in the Total Points value. This value is compared to the 
Victory Values to determine the victory level. If the Total Points is less than the 
Major Defeat value, then the first side suffers a Major Defeat. If the Total 
Points is greater than the Major Defeat value but less than the Minor Defeat 
value, then the first side suffers a Minor Defeat. If the Total Points is greater 
than the Minor Defeat value but less than the Minor Victory level, then the 
battle has resulted in a Draw for both sides. If the Total Points is greater than 
the Minor Victory value, but less than the Major Victory level, then the first 
side has won a Minor Victory. Finally, if the Total Points is greater than the 
Major Victory value, then the first side has won a Major Victory. 

Location Dialog 
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The Location Dialog is used to display a list of all the map locations and to 
allow going directly to any of these locations. 
 

 

Each map location is listed with its label description and hex coordinates. 
Selecting a location causes the map to scroll to the location’s hex coordinate. 
Double clicking on a location also causes the dialog to be closed. 

City Dialog 
 
The City Dialog displays a list of the cities on the current map. 
 

 

Each city is listed with its map location and owner. Selecting an entry scrolls 
the map to that location. Double clicking on an entry also causes the dialog to 
be closed. 

Jump Dialog 
 
The Jump Dialog displays a reduced version of the entire map and allows the 
user to jump directly to any part of the map. 
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The visible on-map units are displayed on the reduced map using blue squares 
for one side and red squares for the other side. The visible portion of the map 
is shown using a red rectangle. The current Hot Spot hex is shown as a red 
outline square. 
 
When the Objectives option of the View Menu is set, then Objectives are 
shown as yellow squares. When the Strategic Targets option of the View Menu 
is set, then Strategic Targets are shown as magenta squares. 
 
Clicking on the reduced map area causes the dialog to be closed and the 
regular map to scroll to the selected location. 

Parameter Data Dialog 
 
The Parameter Data Dialog displays the Parameter Data associated with the 
current scenario. 
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The Parameter Data Dialog consists of a text listing of the scenario values. 
The values are read from the PDT file corresponding to the current scenario. 
 
Basic Values 

Max Stacking – the maximum number of strength points that can be in 
any one hex. 
Rail Movement – the movement allowance of entrained units. 
Sea Movement – the movement allowance of embarked units. 
Days Per Turn – the number of days in each game turn. 
Normal Rail Cost – the movement cost of an entrained unit. 
Snow Rail Cost – the movement cost of entrained units under snow 
conditions. 
Entrain Cost – the movement cost to entrain. 
Embark Cost – the movement cost to embark. 
Interdiction Cost – the additional movement cost for normal units to 
enter an interdicted hex. 
Rail Interdict Cost – the additional movement cost for entrained units to 
enter an interdicted hex. 
ZOC Cost – the additional movement cost to enter the Zone-of-Control 
of an enemy unit. 

 
Supply Values 

Major Supply – the movement allowance used to determine the extent 
of Major Supply. 
Minor Supply – the movement allowance used to determine the extent 
of Minor Supply. 
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Amphibious Supply – the movement allowance used to determine the 
extent of Amphibious Supply. 
Separate Supply – the movement allowance used to determine the 
extent of Separate Major Supply. 
Severe Supply – the movement allowance used to determine the extent 
of Major Supply in Severe areas under certain conditions. 
Isolation Dist – the number of hexes a unit can be from a friendly unit in 
supply and not be Isolated. 
Port Suppression – the number of days a port will be suppressed after 
being occupied by units from the opposing side. 

 
Combat Values 

Combat Cost – the movement cost to initiate combat. 
Combat Base – the base value used to resolve combat. 
Attacker High, Attacker Low – the values used to resolve losses for 
attacking units. 
Defender High, Defender Low – the values used to resolve losses for 
defending units. 
Retreat Base – the odds used to determine retreats after combat. 
Overrun Odds – the odds used to determine overruns. 
Overrun Loss – the nominal losses applied to overrunning units. 
Max Mech Factor – the maximum factor used to determine mechanized 
effects in combat resolution. 
Air Strike Limit – the maximum number of air strength points that can 
attack any one hex in one turn. 
Air Recon Value – the value that is used to determine air recon results. 

 
Nominal Movement Costs 

 By Area, these are the movement costs for non-mechanized units. 
 
Mechanized Movement Costs 

By Area, these are the movement costs for mechanized units. 
 
Concealment Values 

By Area, these are the modifiers units in the specified terrain receive for 
detection by air recon. 

 
Defense Values 

By Area, these are the modifiers units in the specified terrain receive for 
defense. 

Front Data Dialog 
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The Front Data Dialog displays the changes to air availability based on air 
front and weather. 
 

 

For each air front and each weather condition, the number of air units that are 
available for that combination is displayed. When the availability is less than 
100%, then not all of the air units on that front will be available each turn, 
based on a random determination using that probability. 

Nation Data Dialog 
 
The Nation Data Dialog displays information about the various nations having 
units in the game. 
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For each nation, information about that nation is listed: 
• Side identifies the side the nation is assigned to. 
• Uses RR identifies the nation that railroad usage is counted against 

when units from that nation are entrained. 
• Rail Capacity specifies the total number of strength points that can 

be entrained by this nation in any one turn. 
• Air Limit, when nonzero, indicates how far from the country borders 

can air strikes be conducted using air units of that nation. 
• Morale lists the Morale values of the nation in the specified range 

with each value ‘A’ through ‘F’ representing the morale for a year. 
• Attribute lists the attribute values of the nation as described below. 
• Commanded By lists all nations whose headquarters units can be 

used to provide command to units of that nation. 
 
The nation attributes are: 

• C – The nation is represented by a country on the overall map. 
Otherwise, the nation represents a specialized force or off-map nation. 

• S – The nation has special movement characteristics in Severe and 
Moderate Areas in mud and snow conditions as described in the Users 
Manual on Weather. 

• R – The nation’s rail is specific to that nation and of a different rail 
gauge. This makes repair of the line by other nations harder. 

• T – The nation has separate stacking restrictions and cannot stack or 
attack with other nations. 

• U – The nation uses the separate supply value as described in the 
Parameter Data. 

Sea Capacity Dialog 
 
The Sea Capacity Dialog lists the capacity of specified nations to transport 
units through sea areas. 
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For each sea, this dialog lists each nation which an ability to transport units via 
sea movement through the sea and the total number of strength points that 
can be embarked in any one turn. In some cases, before a nation can use the 
specified sea capacity value, there is a port that must be in friendly hands. 

Multi-Player Dialog 
 
The Multi-Player Dialog is used to display the players that are currently 
participating in a Network Play game and their assignments. 
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The dialog shows a list of players on each side of the current battle. Next to 
each list is a display of that side’s nations. At the bottom of the dialog are four 
buttons used to manipulate the player lists and the assignments (Note: only the 
Modem host will have all four buttons enabled). The top player on each side is 
the Commander of that side. The Commander is responsible for making 
nation assignments for the other players on their side and for advancing the 
turn. By default, 
the Commander is
in control of all 
units on that side
The Commander 
can assign other 
players specif
organizations by 
selecting the 
player from the list, selecting the nation from the nation display, and clicking 
the Assign button. The player’s color will appear next to the selected nation. 
This indicates that the player has control of every unit in that nation. The 
Commander can remove an assignment by sele

 

. 

ic 

cting the organization and 

 
n 

ide of any player by selecting the player and clicking the 

n 

displayed in red in the player list indicating they are ready to advance the turn. 

clicking the Deassign button. 
The Modem Host can promote a player from either side to be Commander by
selecting the player and clicking the Promote button. The Modem Host ca
also switch the s
Switch button. 
Only the Commander can advance the turn and place reinforcements. Whe
any other player from a side selects Next Turn, it causes their name to be 
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File Selection Dialog 
 
The File Selection Dialog is displayed when the main program is run if the 
Prompt for Scenario Option has been selected (see the Settings Menu ). 
 

 

The File Selection Dialog allows you to select the mode of play and 
associated game file. 

• Select New to show the list of all scenarios. 
• Select Old (by Name) to show a list of previous battles sorted by 

filename. 
• Select Old (by Date) to show a list of previous battles sorted by date 

with the most recent files listed first. 
Select one of the given play modes such as Normal for play against the 
computer. Finally, select one of the displayed files either by double clicking on 
the filename, or selecting the filename and clicking on OK. Note: when Direct 
Play Caller is selected, no files are displayed since file selection is the 
responsibility of the Direct Play Host in this case. 
 
Select Delete after you have selected to list Old files to delete the selected file. 
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Optional Rules Dialog 
 
The Optional Rules Dialog is used to view and select the Optional Rules for a 
new battle. Optional Rules can be set at the beginning of a battle, but not 
changed once the battle has started. The Optional Rules selected in the 
Optional Rules Dialog are saved and become the subsequent default for new 
battles. 
 

 
 

• Selecting Show all rail states will cause the current rail status of all 
rail lines to be shown. Normally, only those that you occupy or are 
adjacent to are shown to prevent Fog-of-War information leaks about 
the location of enemy units. When this rule is in effect, then rail state 
changes caused my enemy movement will be revealed even when 
you do not have units adjacent to the location. 

 
• Selecting Shown unknown units will cause all enemy units to be 

indicated on the map, even those that you are not adjacent to. 
Normally, these enemy units are not shown unless you perform air 
recon to determine them. When this rule is in effect, successful air 
recon gives additional information about the unit. 

 
• Selecting Large stack penalty will cause the attack factor of all 

artillery and air units to be increased when attacking a defending hex 
containing greater than half the maximum stacking points. The 
intention of this rule is to motivate the player to avoid creating large 
stacks when it is possible to spread out the forces in a more 
continuous line. 
 
For a given stacking value x and a maximum stacking value of m, the 
factor applied is 2x/m whenever x is at least m/2. This means that the 
factor is 1 when x is equal to m/2 and the factor increases to 2 when x 
is equal to m. 

 
• Selecting Use headquarters units will invoke the optional rules 

involving headquarters and their command (see the section on 
Command in the Users Manual). When this rule is not selected, then 
all HQ units in the scenario are removed. 

27 



Main Program Help File 

 

• Selecting No support unit block will prevent support units (Artillery, 
Anti-Air, Anti-Tank) from blocking the retreat of non-support units as a 
result of combat. Under this rule, the support units are eliminated and 
the retreating units can occupy their hex. 

 
Selecting the Default button will set the optional rules setting back to the 
original default. 

Air Support Dialog 
 
The Air Support Dialog is used to select air units for an air mission. 
 

 

Selecting one or more entries in the list and then right clicking on the map 
causes those air units to attack the specified map location. If the Control (Ctrl) 
key is held down while right clicking, an Interdiction attack is invoked. If the Alt 
key is held down while right clicking, then a Port Suppression attack is invoked 
against the selected hex. 
 
Note: you can select more air units in the list than is possible to attack any 
single hex with due to the air strike limit. When you conduct the attack, any air 
units in excess of the air strike limit for the target hex will remain in the list and 
become unselected. You can use these units for subsequent attacks. 
 

 

The following notations designate the type of aircraft: 
• FT – Fighter. 
• BM – Bomber. 
• HB – Heavy Bomber. 
• DB – Dive Bomber. 
• TB – Torpedo Bomber. 
• TR – Transport. 
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• GL – Glider. 
• REC – Recon. 
• JF – Jet Fighter. 
• JB – Jet Bomber. 

 
The values in the entry describe the attributes of the air unit: 

• Each entry shows the number of aircraft in the unit, such as 48 in this 
example. 

• Following the "x" is the Ground Attack value of the unit. In this 
example, the units have a ground attack value of 1. 

• If the unit has a non-zero Anti-Tank value, then it will follow the 
ground attack value in parentheses. This unit has a zero Anti-Tank 
value and so it is not shown. 

• Following the slash is the Air Attack value of the unit. In this example, 
the Air Attack value is 38. 

• The number following that in parentheses is the Defense value of the 
unit. In this example, that is 37. 

• After the dash (-) is the range of the air unit in hexes. In this example, 
the range of the air units is 235 hexes. Note that the maximum range 
the air unit can be used may be limited by air support rules. In any 
case, the hexes that are beyond the effect range of the air unit are 
shaded on the map when the unit is selected. 

Air Availability Dialog 
 
The Air Availability Dialog is used to view the changes in air unit availability 
that are associated with the current scenario. 
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The Air Availability Dialog lists each change in air unit availability associated 
with the current scenario. Each entry is listed according to side, the date of the 
change, and either the word AVAIL indicating that the change will cause the 
affected air units to become available, or NOAVAIL indicating that the change 
will cause the affected air units to become unavailable. 
 
When more than one air unit is affected by the change, the dots (…) are used 
to indicate this. Double-clicking on an entry causes a list of the air units 
affected to be listed. 

Available Replacements Dialog 
 
The Available Replacements Dialog displays a list of available replacements, 
the units they may be used with, and the gives the player the ability to assign 
those replacements. 
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The Available Replacements Dialog shows a list of available replacements on 
the left and a list of eligible units on the right. To assign a replacement to a 
unit, select the replacement and the unit to apply it to. Then click on the Apply 
button. Alternatively, you can double-click on the unit and the selected 
replacement will be applied to that unit. 
 
Note that as you apply replacements to a unit, its effectiveness decreases. 
This represents the fact that new forces are being incorporated into the unit. 

Air Allocation Dialog 
 
The Air Allocation Dialog is used by the player to assign missions to air units 
in each turn and to transfer air units between fronts. 
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Selecting one or more air units and clicking on Superiority will assign those air 
units to air superiority for the current turn or assign them to ground missions if 
they are currently assigned to air superiority. A unit must not be a recon air unit 
and must have an air attack value for it to be assignable to air superiority. 
Selecting one or more units and clicking on Transfer will transfer those air 
units to another front. You will be prompted to select which front to transfer the 
air units to. 
 

 

The following notations designate the type of aircraft: 
• FT – Fighter. 
• BM – Bomber. 
• HB – Heavy Bomber. 
• DB – Dive Bomber. 
• TB – Torpedo Bomber. 
• TR – Transport. 
• GL – Glider. 
• REC – Recon. 
• JF – Jet Fighter. 
• JB – Jet Bomber. 

 
The values in the entry describe the attributes of the air unit: 

• Each entry shows the number of aircraft in the unit, such as 48 in this 
example. 
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• Following the "x" is the Ground Attack value of the unit. In this 
example, the units have a ground attack value of 1. 

• If the unit has a non-zero Anti-Tank value, then it will follow the 
ground attack value in parentheses. This unit has a zero Anti-Tank 
value and so it is not shown. 

• Following the slash is the Air Attack value of the unit. In this example, 
the Air Attack value is 38. 

• The number following that in parentheses is the Defense value of the 
unit. In this example, that is 37. 

• After the dash (-) is the range of the air unit in hexes. In this example, 
the range of the air units is 235 hexes. Note that the maximum range 
the air unit can be used may be limited by air support rules. In any 
case, the hexes that are beyond the effect range of the air unit are 
shaded on the map when the unit is selected. 

Find Unit Dialog 
 
The Find Unit Dialog is used to find specific units on the map. 
 

The Find Unit Dialog allows 
you to enter a string to search 
for. It will then search for that 
string as a substring of names 
of units on the map. Note that 
the search is case sensitive so 
that you must enter the correct 
case, upper or lower, of the 
characters in the string. If the 
name you are looking for is 
unique, then you can hit return 
or press the OK button after 
entering the string. Otherwise, 
press the Search button to see 
a list of units matching your 
string. You can then double-

click a selection to scroll to that unit. 

Withdrawal Dialog 
 

The Withdrawal Dialog is used to 
show the Withdrawals in the 
current scenario. 
 
The Withdrawal Dialog lists the 
Withdrawals in the current 
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scenario. Selecting an entry in this list will scroll the map to the location of the 
unit if it is on the map. 

Strategy Dialog 
 
The Strategy Dialog displays a list of Reinforcement Strategies defined for the 
current scenario. 
 

 

In the list of displayed Strategies, you can double-click on an entry to see the 
Operations associated with that Strategy. 

View Strategy Dialog 
 
The View Strategy Dialog displays a list of Operations associated with a 
Reinforcement Strategy. 
 

 

In the list of displayed Operations, you can double-click on an entry to see the 
list of Reinforcements associated with that Strategy. If this dialog is displayed 
because the Strategy decision time value has been reached, then the 
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Operation you select will be implemented and the reinforcements associated 
with that operation will become part of the current scenario. 
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Other Features 

Hex Info Area 
 
The Hex Info Area displays a list of the units in the Hot Spot hex and 
information about the terrain in that hex. By default, the Hex Info Area is 
displayed on the left hand side of the screen. However, this may be changed 
using the Settings Menu. 
 
Terrain Information 

The Terrain Box at the end of the unit list displays 
information about the current Hot Spot hex. The first line of 
the display is the name of the country the hex is in. If the hex 
contains a city or port, then the name of that city or port is 
shown next. The air front of the hex is listed next. The next 
line shows the terrain type in the hex and the area of the hex. 
 

Port cities are shown with a yellow name followed by either Min when the port 
is a Minor Port or Maj when the port is a Major Port. When the name is shown 
in orange, then it indicates that the port has changed hands recently and is not 
yet up to full capacity. In the case of a Major Port, it means that the port can 
only provide Minor Supply and in the case of a Minor Port, it means that the 
port cannot provide any supply yet. 
 
If the current hex contains a Fortification, then the strength of the Fortification 
is indicated. When the current Hot Spot is an Objective hex, then the Objective 
value of the hex is also shown. Note: Exit Objective hexes will have the word 
Exit on this line and Surrender Objectives will have the word Surrender on 
this line. If the current hex is a Supply Source for either side, then this is 
indicated. If the current hex contains a rail line, then the ownership of that line 
is indicated, unless Fog-of-War prevents that from being known. 
 
When a city or port is captured by the enemy, then the name 
of the capturing country appears in red above the name of the 
city or port. If enemy forces occupy a hex containing a rail 
line, then the fact that this causes rail damage is noted in the 
display. 
 

Alternative Terrain Information 
Clicking on the Terrain Box with the right mouse button 
causes the display to change to the Alternative display. In this 
display, the text area changes to show a description of the 
various hex sides that are present in the hex. The names of 
the hex sides are arranged in a rough hexagonal pattern 
around the center of the text area showing the position of the 
hex side with respect to the hex. The value in the center of t
number of strength points in the hex. 

his display is the 

36 



Other Features 

 
Unit Information 

The Hex Info area is filled with Unit Box displays. 
The number of these depends on your screen 
resolution. The Unit Box shows a representative 
picture of the unit, its name, its Strength, its 
Movement value, its Combat values, and its current 
Effectiveness level. If the name is followed by a 
plus sign (+), then it indicates that the unit

components. Other conditions associated with the unit are displayed as 
follows: 

 has 

• When the Movement value is followed by the letter R, it indicates the 
unit is a rail unit that can only travel by rail lines. 

• When the Movement value is followed by the letter T, it indicates the 
unit is entrained for rail movement. 

• When the Movement value is followed by the letter S, it indicates the 
unit is embarked for sea movement. 

• When the words Has Fought appear in place of the Movement value, 
it means the unit has participated in combat and cannot move anymore 
that turn as a result. 

• When the words Mech Move appear before the Movement value, it 
means the unit has participated in combat, but can still move that turn. 

 
Alternative Unit Information 
Clicking on a Unit Box with the right mouse button 
shows additional information about the unit. This 
begins with the type of the unit, followed by the 
country it belongs to and the side it is fighting on. 
Next the component type is shown. The number of 
components that make up the unit is displayed 
followed by the full strength of the unit. The final line 
shows the Armor, AT, and AA values of this unit. 
 

When there are more units in the Hot Spot hex than can be displayed in the 
available Unit Boxes, then scroll arrows that appear after the list of units can 
be used to scroll the Unit Boxes. When the left or top arrow is displayed in full 
color, there are units to the left or top of the displayed units and when the right 
or bottom arrow is displayed in full color, there are units to the right or bottom 
of the displayed units. In addition, the numbers which appear associated with 
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each scroll arrow indicate the number of hidden units in the corresponding 
direction. 

Toolbar 
 
The main program has a Toolbar at the top of the main program window just 
under the Menu Bar. Note: depending on your screen resolution, only some of 
these buttons may be displayed on your screen. You need a screen width of at 
least 1024 before all of the buttons are displayed. Note that most all of these 
buttons implement a menu selection and the command may be issued as a 
menu selection when the button is not displayed. 
 

New – start a new battle. 
 
Open - opens an existing battle file. 
 
Save - save current battle under existing filename or prompt for filename if 
none. 

 
Next – advance game to next turn. 
 
Entrain – toggle entrain status of selected units. 
 
Embark – toggle embarkation status of selected units. 
 
Combine – combine selected units into a single unit or break out a 
component from a unit with multiple components. 
 

 

Force March – activate Force March mode for valid selected units. 
 
Air Support – display the Air Support Dialog so that air missions can be 
initiated. 

Resolve – resolve current Assault. 
 
Arrived Units – display Arrived Dialog. 
 
Next – jump to the next unit that has not moved or fought in the current 
turn. 
 
Zoom-In – increase map display scale. 
 
Zoom-Out – decrease map display scale. 
Normally the screen is recentered on the Hot Spot hex when you change 

zoom modes. If you hold down the Alt key when you change zoom modes, the 
screen will retain the current view. 
 

Objectives - toggle the display of objectives on the map. 
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Ownership – toggle the display of city ownership on the map. 
 
Sources – toggle the display of supply sources on the map. 
 
Units - toggle the display of units on the map. 
 
Organizational – toggle the display of organizational colors on the units on 
the map. 

 
Jump Dialog - display the Jump Dialog so you can quickly go to another 
part of the map. 

 
Reachable Hexes – shade the map to show hexes reachable by the 
currently selected unit. 

 
Major Supply – shade the map to show hexes that are within Major 
Supply distance from the current hex. 

 

 
Command – shade the map to show hexes that are within the command 
range of the selected HQ unit. 

 
Highlight Fought – toggle the Highlight of units that have fought this turn. 
 
Highlight Moved – toggle the highlight of units that have moved this turn. 
 
Highlight Fixed - toggle the highlight of Fixed units. 
 
Highlight Reduced – toggle the highlight of units of half-strength or less. 
 
Highlight Supply – toggle the highlight of mobile supply units. 
 
Highlight Repair – toggle the highlight of rail repair units. 
 
Highlight HQ – toggle the highlight of headquarters units. 
 
Highlight Entrained – toggle the highlight of entrained units. 
 
Highlight Out-of-Supply – toggle the highlight of units that are out-of-
supply. 

Highlight Detached – toggle the highlight of Detached units. 
 
General Help - display this help file. 

Status Bar 
 
The Status Bar is located at the bottom the main window and displays status 
information about the current battle. 
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The Status Bar typically displays the current turn and date information together 
with the hex coordinates of the Hot Spot If the current turn is being played 
using A/I, then A/I Control will appear with the turn and date information. If you 
are playing a two-player game, then Local Control will be displayed in the 
Status Bar when the current turn is under your control, and Remote Control 
will be displayed when the current turn is under the control of your opponent. 
 
If you make an error during play, the main program will beep (depending on 
the setting in the Settings Menu) and the error message will be displayed in the 
Status Bar. Otherwise, as you move the mouse cursor over Toolbar buttons 
and menu items, short descriptions of those commands will appear in the 
Status Bar. 

Hot Keys 
 
The following Hot Keys are supported in the main program. Note that these 
Hot Keys are defined as command accelerators of the main program main 
window and therefore the main window must have the keyboard focus for 
these to work (that is, the main window must have a highlighted title bar). 
 
Shift Key - display the on-map labels while this key is pressed. 
 
F1 - invoke General Help (display this help file). 
F2 – display the Users Manual help file. 
F3 – display the Campaign Notes help file. 
F4 – display the Parameter Data values. 
F9 – display the Nation Data Dialog. 
F10 – display the Front Data Dialog. 
 
F5 – slow the speed of the A/I processing. 
F6 – return A/I processing to normal speed. 
F7 – increase the speed of the A/I processing. 
F8 – put the A/I in the highest possible processing mode (use F6 to return to 
normal). 
 
C – clear all highlighting and shading on the map. 
J – display the Jump Map. 
K – shade the command range of the currently selected headquarters unit. 
N – advance the Hot Spot to the next stack of units that have not been active 
this turn. 
R – shade the reachable hexes of the currently selected units. 
U - undo the last movement (not available under Fog-of-War). 
 
1 - display the map in Zoom-Out mode. 
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2 - display the map in Normal mode. 
Normally the screen is recentered on the Hot Spot hex when you change zoom 
modes. If you hold down the Alt key when you change zoom modes, the 
screen will retain the current view. 
Keypad 1 - move the selected units down and to the left one hex. 
Keypad 2 - move the selected units down one hex. 
Keypad 3 - move the selected units down and to the right one hex. 
Keypad 7 - move the selected units up and to the left one hex. 
Keypad 8 - move the selected units up one hex. 
Keypad 9 - move the selected units up and to the right one hex. 
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